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Sun Java™ System Application Server
Platform Edition 8 Update 1
Release Notes
June 2004

Part Number 817-7422

These release notes contain important information available at the time of the Update 1 release of
the Sun Java™ System Application Server Platform Edition 8 product. Enhancements, installation
notes, known problems, and other late-breaking issues are addressed here. Read this document
before you begin using the Application Server Platform Edition 8 Update 1 product.

This document contains the following sections:

• What’s New in the Application Server

• Bugs Fixed in This Release

• System Requirements

• Documentation

• Known Problems and Limitations

• How to Report Problems

• For More Information

• Revision History

What’s New in the Application Server

In addition to the features introduced with the Sun Java™ System Application Server Platform
Edition 8 product, the Update 1 product provides the following additional enhancements:

• Many customer-escalated issues have been resolved.

• JavaServer Faces has been upgraded to version 1.1. For more information on changes and
bug fixes, see the JavaServer Faces Release Notes at:
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http://java.sun.com/j2ee/javaserverfaces/docs/ReleaseNotes.html

• Sun Java™ Studio Creator now includes the Application Server 8 Update 1 to address the
needs of Java application developers. For more information on Sun Java Studio Creator see:

http://developers.sun.com/prodtech/javatools/jscreator/index.jsp

Bugs Fixed in This Release

This section lists the customer-escalated issues resolved for the Sun Java™ System Application
Server Platform Edition 8 Update 1 product.

Table  1 Fixed Bugs in Application Server Platform Edition 8 Update 1

Bug Number Description

4817526 Container resources unavailable outside of request thread

4963035 Negative Incorrect failure. Class cannot be found within this jar (WebEjbReferences)

4987274 Deployment fails if remote interface for the bean is named Util

4991198 Appserver logs user passwords in CLEAR TEXT in the log file

5004437 Redeployments can fail on Windows due to open file streams

5005189 Argument type mismatch error occurs with overridden MCF/RA methods during RAR deployment

5005572 stateful-simple.ear encounters verifier error for AppClientEjbReferencesElement

5005581 bmp-robean.ear encounters incorrect verifier warning for ASEjbIsReadOnlyBean test

5005808 samples.jar has a missing sample - jaxrpc-simple

5006160 ests.appclient.elements.AppClientEjbReferencesElement prints incorrect information

5006854 asadmin deploy --virtualservers fails to deploy

5008967 Application Server deletes tool provided data fields from sun-web.xml after deployment

5009555 asadmin with enable assertion (-ea) ON does not work and exits immediately

5010332 OSS/J IBP TCK tests have 9 failures

5012781 While inside service(), session shouldn’t be invalid after setMaxInactiveInterval

5015554 update-file-user command removes group

5015922 Timer operations are not allowed after entity timed object finder exception

5016561 JSP debugger issues caused by server issues

5018278 javax.naming.NamingException after a Stop/Start cycle of a web application

http://java.sun.com/j2ee/javaserverfaces/docs/ReleaseNotes.html
http://developers.sun.com/prodtech/javatools/jscreator/index.jsp
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System Requirements

This section lists the requirements that must be met before installing the Sun Java System
Application Server Platform Edition 8 Update 1 product.

• Platform Requirements

• JDBC Drivers and Databases

• Other Requirements

Platform Requirements
The following table lists the operating systems that are supported for Sun Java System Application
Server product.

5026588 XA Connections are shared even outside transaction context

5030425 deploydir ignores security-role-mapping changes

5036455 Need to include Verisign CA certs in application server trust store

5036984 Keep Alive algorithm breaks SPECJ 2002

Operating System Architecture Minimum
Memory

Recommended
Memory

Minimum
Disk Space

Recommende
d Disk Space

JVM

Sun Solaris 8, 9
(SPARC)

32 and 64 bit 256 MB 512 MB 250 MB free 500 MB free JDK
1.4.2_04

Solaris 9 (x86) 32 and 64 bit 256 MB 512 MB 250 MB free 500 MB free JDK
1.4.2_04

Sun Java Desktop
System

32 bit 256MB 512MB 83 MB free 300 MB free JDK
1.4.2_04

Redhat Enterprise
Linux 2.1 and 3.0

32 bit 256 MB 512 MB 83 MB free 300 MB free JDK
1.4.2_04

Microsoft Windows
2000 Professional
Service Pack 4+

Intel 32 bit 256 MB 512 MB 250 MB free 500 MB free JDK
1.4.2_04

Table  1 Fixed Bugs in Application Server Platform Edition 8 Update 1

Bug Number Description
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On UNIX, you can check your operating system version using the uname command. Disk space can
be checked using the df command.

Solaris Patch Requirements
It is recommended that Solaris 8 and 9 users have the Recommended Solaris Patch Cluster installed.
This patch cluster is available under “Recommended and Security Patches” here:

http://sunsolve.sun.com/

RedHat Enterprise Linux 3.0 Additional Package Requirements
To run native components of this product, including installer, the following package, which is not
part of the standard RedHat Enterprise Linux 3.0 distribution, should be installed:

compat-libstdc++-7.3-2.96.118.i386.rpm

The package can be downloaded from:

http://mirrors.kernel.org/redhat/redhat/linux/9/en/os/i386/RedHat/RPMS/compat-libstdc++
-7.3-2.96.118.i386.rpm

JDBC Drivers and Databases
The Sun Java System Application Server is designed to support connectivity to any DBMS with a
corresponding JDBC driver. For a list of components that Sun has tested and found to be acceptable
for constructing J2EE compatible database configurations, please refer to the following table:

Microsoft Windows
XP Professional
Service Pack 1+

Intel 32 bit 256 MB 512 MB 250 MB free 500 MB free JDK
1.4.2_04

Microsoft Windows
2000 Server SP4+

Intel 32 bit 256 MB 512 MB 250 MB free 500 MB free JDK
1.4.2_04

Microsoft Windows
Advanced Server
Service Pack 4+,
Microsoft Windows
Server 2003

Intel 32 bit 256 MB 512 MB 250 MB free 500 MB free JDK
1.4.2_04

Operating System Architecture Minimum
Memory

Recommended
Memory

Minimum
Disk Space

Recommende
d Disk Space

JVM

http://sunsolve.sun.com/
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For more information about i-net Software, see:

http://www.inetsoftware.de/

The following table identifies additional supported JDBC drivers; however these drivers are not
J2EE compatible.

Additional drivers have been tested to meet the JDBC requirements of the J2EE 1.4 platform with
the JDBC Driver Certification Program. These drivers can be used for JDBC connectivity with the
Sun Java System Application Server. While Sun offers no product support for these drivers, we will
support the use of these drivers with the Sun Java System Application Server.

Other Requirements
The following additional requirements should be met before installing the Sun Java System
Application Server software.

• Free space: your temporary directory must have a minimum of 35MB free for Sun Java
System Application Server installation, and 250 MB of free space for the SDK installation.

Table  2 J2EE Compatible JDBC Drivers

JDBC Vendor JDBC Driver Type Supported Database Server

i-net Software Type 4 Oracle (R) 9.2, 8.17

i-net Software Type 4 Sybase ASE 12.5.1

i-net Software Type 4 MS SQL Server 2000 Service Pack 1

IBM Type 2 IBM DB2 8.1 Service Pack 3

PointBase Type 4 PointBase Network Server 4.8

Table  3 JDBC Drivers not J2EE compatible

JDBC Vendor JDBC Driver Type Supported Database Server

Oracle Type 4 Oracle (R) 9.2

Sybase jConnector Sybase ASE 12.5.1

http://www.inetsoftware.de/
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• Using the uninstall program: If you need to remove the application server from your
system, it is important to use the uninstall program that is included with the software. If
you attempt to use another method, problems will arise when you try to reinstall the same
version, or when you install a new version.

• Free ports: You must have seven unused ports available.

❍ The installation program automatically detects ports in use and suggests currently
unused ports for the default settings. By default, the initial default ports are 8080 for
the HTTP server, and 4848 for the Admin Server.

❍ The installation program will detect used ports and assign two others for you: Sun
JavaTM System Message Queue (by default, 7676), and IIOP (by default, 3700 for IIOP
and 1060 and 1061 for IIOP/SSL). If these default port numbers are in use, the
installation program will assign a random port number from the dynamic port range
(note that this may not be the next available port number).

• Starting previously-installed servers (UNIX) — unless you are replacing the previously
installed server, you should start it before you begin the Sun Java System Application
Server installation process. This allows the installation program to detect ports that are in
use and avoid assigning them for other uses.

• Replacing previously-installed servers (UNIX) — if you have an older version of the Sun
Java System Application Server 7 installed that you wish to replace with the current
Application Server, you should stop it before installing the new server. Use the installation
program upgrade wizard to upgrade the server.

• Shutting down firewall (Microsoft Windows) — You must stop any firewall software
before installing the Sun Java System Application Server software, because some of this
software disables all ports by default. The installation program must be able to accurately
determine which ports are available.

For further compatibility information, see the Compatibility Guide available at:

http://docs.sun.com/db/doc/817-6084

Documentation

In addition to these release notes, the Application Server product includes an entire set of
documentation that can be found at this location:

http://docs.sun.com/db/prod/s1appsrv#hic

http://docs.sun.com/db/doc/817-6084
http://docs.sun.com/db/prod/s1appsrv#hic
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The following list provides a brief description of the documentation in the Application Server
collection:

• Quick Start Guide—Describes how to get started with the Application Server product.
Focuses on initial developer exposure; is also suited for users evaluating the product.

• Installation Guide—Provides instructions for installing or uninstalling the Application
Server software and its components. Supported platforms are listed.

• J2EE 1.4 Tutorial—Describes how to develop software using the technologies provided in
the Application Server product. You can find the J2EE 1.4 Tutorial here:

http://java.sun.com/j2ee/1.4/docs/tutorial/doc/index.html

• Compatibility Guide—Provides information on backward compatibility issues.

• Utility Reference—Documentation for all command-line interface commands and the
Application Server utility commands.

• Online help for the Admin Console—Provides content-specific online help for the
Application Server Administration Console web-based interface.

• Online help for the deploytool utility—Provides content-specific online help for the
Application Server deploytool utility.

• Online help for the Migrationtool utility—Provides content-specific online help for the
Application Server Migrationtool utility. The Migration Tool is available for a separate
download.

• Troubleshooting Guide—Provides information on solving problems associated with the
Application Server product.

Known Problems and Limitations

This section describes known problems and associated workarounds for the Sun Java System
Application Server 8 product. If a summary statement does not specify a particular platform, the
problem applies to all platforms.
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ID Summary

none A slight behavioral change in the client stubs generation.

The client stubs are generated during deployment process. The deploy operation does not return until
the client subs are fully generated.

For performance concerns, the client stubs generation has been modified to be an asynchronous
operation within deployment when the retrieval of client jars is not explicitly requested by the user; the
client stubs are no longer guaranteed to be ready for use upon return of the deployment operation.

Solution

Do not copy any client jars directly out of the repository post deployment. Instead, the following ways
are the recommended ways to retrieve client stubs with guaranteed integrity:

Command-line interface:

1. asadmin deploy --retrieve=true

2. asadmin get-client-stubs

Deploytool:

1. Specify retrieval of client jars on the deploy screen.

2. Check the client jar retrieval screen for any deployed applications.

5002049 Manpages are incorrect for the create-jvm-options and update-connector-security-map.

Solution

1. The EXAMPLE for the create-jvm-options command should read:

./asadmin create-jvm-options --user admin -w adminadmin --profiler=false --host localhost --port 4848
-- "-Debug=true":"-Xmx256m":"-Dcom.sun.aas.imqBin=⁄export⁄as8pe⁄imq⁄bin"

Command create-jvm-options executed successfully

2. The SYNOPSIS for the update-connector-security-map command should read:

update-connector-security-map --user admin_user [--password admin_password] [--host localhost]
[--port 4848] [--secure|-s] [--passwordfile filename] [--terse=false] [--echo=false] [--interactive=true]
--poolname connector_connection_pool_name [--addprincipals principal-name[, principal-name]*]|
[--addusergroups user-group[, user-group]*] [--removeprincipals principal-name[, prinicpal-name]*]
[--removeusergroups user-group[, user-group]*] [--mappedusername user_name] [--mappedpassword
password] mapname
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5002174 On Microsoft Windows, intermittent corruption of PATH environment variable content after
product uninstallation.

If the “Add bin directory to PATH” installation option is selected during installation, content of PATH
environment variable may get corrupted after installation.

The corrupted PATH variable will have a random set of characters appended as the last entry in the
PATH. This additional PATH entry generally will not affect system functioning.

Solution

Use the Windows Control Panel, System, Advanced, Environment variables tool to edit the content of
the PATH environment variable and remove the superfluous characters.

5003356 Missing entries in server.policy file after upgrade.

User chooses to upgrade from Sun ONE Application Server 7.x Platform Edition to Sun Java System
Application Server Platform Edition 8. After the upgrade process is complete, the updated server.policy
file looses two entries that were existing prior to the upgrade.

Solution

Edit install_dir/domains/domain_name/config/server.policy file as follows:

1. Add the following lines to the end of the file:

//ANT classes get all permissions by default
grant codeBase “file:${com.sun.aas.antLib}/-” {
permission java.security.AllPermission;

};

2. Locate “// Basic set of required permissions granted...” block in the file. Add the following lines
inside this grant block:

// work-around for pointbase bug 4864405
permission java.io.FilePermission “${com.sun.aas.instanceRoot}${/}-”, “delete”;

The original server.policy file, before upgrading, is saved in the same directory with file named
server.policy.back. Please refer to this file to identify where the missing lines were placed.

ID Summary
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5004911 Using Deploytool, unable to deploy an application with database mappings that were
automatically created.

The problem occurs after creating database mappings and then trying to deploy the application.

Create database mappings:

1. Select a CMP EJB in the Files tree view.

2. Click on the Sun-specific Settings button in the EJB JAR General tab to display the CMP Database
dialog.

3. Click on the Create Database Mappings button to display the dialog.

4. In the Create Database Mappings dialog, select Automatically Generate Necessary Tables.

5. Select OK.

6. Close the CMP Database dialog.

Deploy the application:

1. Select the application in the Files tree view.

2. Select Deploy from the Tools menu.

The application is not deployed and the following error is displayed:

Referenced schema is not present in jar: RosterAppJ2DB_team-ejb
Adding the schema and saving the archive
or replacing the mapping, by triggering the Create Database Mapping action, will correct this.

Solution

Dismiss the error dialog.

Save the application:

1. Select the application in the Files tree view.

2. Select Save from the File menu.

Deploy the application:

1. Select the application from the Files tree view.

2. Select Deploy from the Tools menu.

ID Summary
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5005059 Using Deploytool, when two CMP EAR files are opened with the same name, the mapping is not
displayed for the second EAR.

To view the mapping, select the Sun-specific Settings button in the EJB JAR General tab to display the
CMP Database dialog. A Packaging Warning message is displayed: Referenced schema not present in
jar... No mapping is displayed for the second EAR opened.

If you attempt to perform the mapping again, another error message is displayed: Cannot create
schema from cmproster.dbschema. Please check the schema file...

Solution

Close the first application and remove earname.dir under the deploytool temporary directory. The
temporary directory location is displayed on the General panel of the Edit Preferences dialog. Select
Preferences under the Edit menu to display the Edit Preferences dialog.

5005168 On Microsoft Windows, while using Deploytool, after adding a CMP EJB to an EAR file, it may
not be possible to create database mappings for that EJB.

When adding a CMP EJB that has a dbschema file to an EAR, an exception is thrown and the
mappings dialog cannot be closed. Deploytool must be terminated externally.

Add CMP EJB that has a dbschema file to an EAR:

1. Select Add to Application --> Enterprise JavaBean JAR from the File menu.

Create database mappings:

1. Click on the Sun-specific Settings button on the EJB JAR General tab to bring up the CMP
Database dialog.

2. Click on the Create Database Mappings button.

3. Select Map to Tables in Database Schema File and choose the schema file.

When trying to create database mappings, an exception is thrown and the mappings dialog cannot be
closed: javax.ejb.EJBException: nested exception is: java.lang.ClassNotFoundException

Solution

After adding the CMP EJB to an EAR, save the application:

1. Select the application in the Files tree view.

2. Select Save from the File menu.

Restart deploytool:

1. Select Exit from the File menu.

2. Start deploytool.

Create database mappings:

1. Click on the Sun-specific Settings button on the EJB JAR General tab to bring up the CMP
Database dialog.

2. Click on the Create Database Mappings button.

3. Select Map to Tables in Database Schema File and choose the schema file.

ID Summary
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5005169 Using Deploytool, cannot Create Database Mappings from a dbschema file that has been added
to a CMP EJB which is embedded in an EAR and already contains a dbschema file.

The problem happens when a second dbschema file is added to a CMP EJB which is embedded in an
EAR and already contains a dbschema file. The database mappings cannot be created from the
second dbschema file.

Solution

1. Save the application.

2. Restart the deploytool.

3. Create database mappings using the newly added dbschema file:

•Click on the Sun-specific Settings button on the EJB JAR General tab to display the CMP
Database dialog.

•Click on the Create Database Mappings button.

•Select Map to Tables in Database Schema File and choose the newly added schema file.

•Click OK.

5005792 Unsupported: RedHat Fedora (core 1) requires the libstdc++ package to be installed in order to
install J2EE1.4SDK.

Solution

The install package named compat-libstdc++-7.3-2.96.118.i386.rpm can be found on disk 3 of the
Fedora ISO installation CD image for corel.

5009854 Intermittent Power User installation failure on Windows platform while creating server domain

Installation run by Power User on Windows platforms fails during the domain creation and the following
error is logged in installation log file:

ERROR - default domain creation returned following exception: abnormal
subprocess termination: Detailed Message:’?#’ is not recognized as an
internal or external command, operable program or batch file.

Solution

Since this problem happens intermittently, another installation can be attempted after uninstalling the
content of the original installation using provided uninstaller.

Since all necessary product files will be installed by such installation, another option is to create
missing default domain manually using asadmin command. In order to create the domain, the
install_dir\domains\domain1 folder should be deleted and the following command should be run:

install_dir\bin\asadmin create-domain --adminport admin_port --adminuser
admin_user --adminpassword admin_password --instanceport http_port domain1

Values for admin_port, admin_user, admin_password, and http_port should match the values that
were originally supplied at product installation.

ID Summary
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5013585 On Windows,adding the Application Server /bin directory to the PATH doesn’t take effect
immediately.

If the installation option to add Application Server /bin directory to the user’s PATH environment
variabe is selected, installer will correctly update the variable value, but the new value will not
automatically take effect.

Solution

To force a refresh of the environment settings any one of following actions can be taken after the
installation:

• Apply environment changes by selecting Start->Settings->Control Panel->System. Select the
"Advanced" tab. Click on "Environment Variables" button. Click on "OK" button.

• Logout of the current user session and log back in.

5014416 Documentation neglects to provide directions for supporting unknown Primary Key in CMP
beans.

Solution

To use unknown Primary Key feature for a CMP bean, do the following:

1. Do not define primary key fields in your bean.

2. Define primary key class as java.lang.Object in deployment descriptor.

If you map your CMP bean to an existing table, make sure the table:

• has only one primary key column

• is not mapped to any other CMP field

• is a NUMERIC type with precision 19 or higher (to store a long value)

If you rely on the CMP module to generate the mapping, you do not need to perform any other steps.
When such a bean is created, the primary key value will be populated by the Persistence Manager.

5014452 Addendum to the Sun Java System Application Server 8 Developer’s Guide.

Solution

Added support for CMP beans with java.lang.String primary key fields mapped to a fixed length
character.

ID Summary
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5014466 Addendum to the Sun Java System Application Server 8 Developer’s Guide.

Solution

Supporting join table to map all types of CMP relationships:

CMR field that represents 1-N (0r 1-1) relationship between CMP beans can now be mapped to join
table.

For example:

• Department bean is mapped to a DEPARTMENT table with a primary key column “deptid”.

• Employee bean is mapped to an EMPLOYEE table with primary key column “empid”.

• CMR field “employees” in a Department bean is a 1-N relationship to an Employee bean, and
represents a Collection of employees in this department.

• This field can be mapped:

• Either by a foreign key “deptid” field in an EMPLOYEE table

• Or a join table EMPLOYEE_DEPARTMENT with columns “empid” and “deptid” that are
both foreign keys to the corresponding columns in EMPLOYEE and DEPARTMENT tables.
you might consider a unique constraint on the “empid” column to guarantee that each
Employee belongs to only one department.

5043719 Standalone web module gets loaded on all virtual servers after restart.

When a standalone web module is deployed to specific virtual servers (by specifying the
--virtualservers option to the asadmin deploy command), the web module will be accessible only
through those HTTP listeners associated with the specified virtual servers. However, after stopping and
restarting the server, the web module will be deployed to all configured virtual servers (not just the
previously specified ones) and accessible through their associated HTTP listeners.

Solution

When a web module is to be deployed to a subset of virtual servers only, it must be wrapped inside an
EAR file.

5050743 Documentation neglects inform user of the clear-text passwords stored in the Application
Server files.

Following files can contain clear-text passwords. Users should verify that these files have appropriate
permission settings in order to avoid unauthorized access.

$HOME/.asadminprefs (Unix)
%USERPROFILE%˙asadminprefs (Windows)
installdir/domain.xml

ID Summary
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How to Report Problems

Use the following resources to handle problems you may encounter with the Application Server
product:

• Feedback Submittal form—A form for submitting feedback on the Application Server
product, here:

http://java.sun.com/docs/forms/J2EE14SubmittalForm.html

• J2EE-INTEREST list—A mailing list for J2EE questions, here:

http://archives.java.sun.com/archives/j2ee-interest.html

5052205 Wrong error message for JSP pages whose java code has syntax errors.

If a JSP page contains scriptlet code that is syntactically incorrect (e.g., opening brace does not have
matching closing brace), the following error message may be returned to the client:

org.apache.jasper.JasperException: Unable to compile class for JSP
No Java compiler was found to compile the generated source for the JSP.
This can usually be solved by copying manually $JAVA_HOME/lib/tools.jar from
the JDK to the common/lib directory of the Tomcat server, followed by a
Tomcat restart. If using an alternate Java compiler, please check its
installation and access path.

This error message is misleading and should be ignored. It is being caused by a bug in the way
compilation error messages for scriptlets are being propagated.

Solution

Check server log file for root cause of JSP compilation errors.

5052946 capture-schema with Oracle LOB data types.

The capture-schema utility will not successfully capture all of the table information needed by the CMP
container if you are using the inet Oraxno 2.06 or later driver. The maximum size for a LOB DataType
on Oracle is 4GB. Starting with inet Oraxno release 2.06, the JDBC driver will not return the correct
size of 4GB for a LOB via DatabaseMetaData.getColumns().

Solution

You may use a a previous version of the inet Oraxno driver with capture-schema as a workaround. This
will not effect the use of the Oraxno 2.06 driver with the Sun Java System Application Server after you
capture the information for the schema.

This issue will be addressed in a future Sun Java System Application Server release.

ID Summary

http://java.sun.com/docs/forms/J2EE14SubmittalForm.html
http://archives.java.sun.com/archives/j2ee-interest.html
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• Bug database on Java Developer Connection—To view bugs or to submit a bug, use the
Java Developer Connection Bug Parade here:

http://developer.java.sun.com/servlet/SessionServlet?url=/developer/bugPar
ade/index.jshtml

• Java Technology Forums—An interactive message board for sharing knowledge and
questions about Java technologies and programming techniques. Use the J2EE SDK forum
here for discussions related to the Sun Java System Application Server 8 Platform Edition
product:

http://forum.java.sun.com/forum.jsp?forum=136

For More Information

Useful information can be found at the following locations:

• Application Server product information:

http://wwws.sun.com/software/products/appsrvr_pe/index.html

• Java developer resources:

http://developer.java.sun.com/

• Java 2 Platform, Enterprise Edition (J2EE) site:

http://java.sun.com/j2ee/

• Application Server product documentation:

http://docs.sun.com/db/prod/s1appsrv#hic/

• Sun Microsystems product documentation:

http://docs.sun.com/

http://docs.sun.com/
http://wwws.sun.com/software/products/appsrvr_pe/index.html
http://developer.java.sun.com/servlet/SessionServlet?url=/developer/bugParade/index.jshtml
http://forum.java.sun.com/forum.jsg?forum=136
http://developer.java.sun.com/
http://docs.sun.com/db/prod/s1appsrv#hic/
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Revision History

This section lists the changes that have been made in these release notes after the initial release of
the Application Server product

Revision Date Description of Change

June 2004 Sun Java System Application Server Platform Edition 8 Update 1 release.
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